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VoiceWorks 16

Installer software

General overview
VoiceWorks 16 Installer is a Windows® 95/98-based application that provides the installer the
means to program the VoiceWorks 16 either on-line, via the serial port or modem, or off-line.
Installer provides the capability of programming nearly every function in the system’s
operation, except for re-initialization and prompt recording, which must be done through a
telephone set.
Additional functionality includes back-up and restore, of the system program configuration,
either on-site or remotely. Back-ups may be stored on either the PC’s hard drive or a 3.5″
floppy disk. Read this guide carefully before attempting these procedures, as there are
special notes of which you must be aware.
Included with this application are .PDF (Adobe Acrobat) files of all pertinent documents — the
Installation Manual, Administrator Manual, User’s Guide and User’s Pocket Guide. These
documents require that Adobe® Acrobat® Reader be installed on the computer with the
Installer, which uses Acrobat Reader to let you view and print them.
Important: Please note that Acrobat Reader is not included in this software package. As of
this writing, Acrobat Reader is available as a free download on the Internet. The
Adobe Web site is www.adobe.com.
Important: The first time you run Installer, the program will prompt you to “Specify the
directory containing AcroRd32.exe.” AcroRd32.exe is the actual name of the
Acrobat Reader program. Typically, the directory will be named something like
“C:\Acrobat3” but, obviously, this will depend on the settings you used to install
Acrobat Reader.
Because you already have the documents that actually teach you how to program
VoiceWorks 16 itself, we will not attempt in this manual to teach that. Instead, we merely will
provide a summary of how the software works and pass along a few cautionary tips here and
there. The best and fastest way to learn the software is to use it, so long as you know
how to program VoiceWorks 16.

System requirements
To install and run VoiceWorks 16 Installer, you need an IBM®-compatible PC with:
•
•
•
•
•
•
•
•
•

A 486SX/66 MHz (or higher) processor.
Microsoft® Windows 95 or 98 operating system.
16 MB of RAM if using Windows 95, 24 MB if using Windows 98 (however, additional RAM
significantly improves performance)
A minimum of 30 MB of available hard disk space.
A 3.5″ 1.44 MB floppy drive.
VGA (or better) monitor; supported resolution settings include 640 × 480 to 1024 × 768
(although we recommend 800 × 600 for best appearance).
Pointing device, such as a mouse.
Available RS-232C serial port (for on-site programming).
Modem (for remote programming).
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Installation
To install VoiceWorks 16 Installer using Windows 95/98:
1.
2.
3.
4.
5.
6.

Turn on your PC and wait until Windows 95/98 has finished loading.
Close any applications that may be running.
Insert the CD-ROM into the PC. Give the CD-ROM drive approximately 10 seconds to “spin
up” and read the CD-ROM.
Open Windows Explorer and double-click on the CD-ROM drive icon. The CD-ROM’s
contents will appear.
Double-click on Setup (it may appear as Setup.exe, depending on your Windows settings) in
the CD-ROM contents window.
Follow the instructions as they appear on the screen. We recommend that you use the
defaults, unless you are sure that they will be inappropriate for your computer.

Running the software
To run VoiceWorks 16 Installer:
1.
2.
3.
4.
5.

Close any applications that may be running.
Click on the Start button on the Windows 95/98 taskbar.
Click on Programs.
Point to the program group which contains VoiceWorks 16 Installer (unless you specified
otherwise during the setup, the program group will be ESI).
Click on VW16 Installer.

Important: The first time you run Installer, the program will prompt you to “Specify the
directory containing AcroRd32.exe.” AcroRd32.exe is the actual name of the
Acrobat Reader program. Typically, the directory will be named something like
“C:\Acrobat3” but, obviously, this will depend on the settings you used to install
Acrobat Reader.

Important: You’ll notice that the Windows 95/98 taskbar disappears when you run
Installer. This is because we’ve designed Installer to use the maximum
screen height, thus allowing you to see more information at a time.
If you wish to switch back and forth between/among Installer and other
Windows applications, use the standard Alt-Tab keystroke to do so.
(When you switch to an application other than Installer, the Windows taskbar
will probably reappear; it depends on the individual application.)
As an alternative, you may also click on the “minimize” icon (
) in the
upper right corner of the Installer screen, allowing you to see your normal
Windows desktop.
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VoiceWorks 16 Installer conventions
Function numbers
This installation package follows the same basic convention as DTMF programming. (Consult
your VoiceWorks 16 documentation if necessary.) Each programming variable is designated
by a function number. Function numbers are grouped according to the operation(s) each
performs. For example, all programming in F-11 involves interfacing VoiceWorks 16 to the
telephone system, while all mailbox programming is grouped under F-5. Functions are then
divided further into sub-functions by lengthening the function number — e.g., F-51. To reach
the primary functions, use the navigation buttons at the bottom of the screen; to reach
sub-functions, use the Programming menu. (See below.)
Left: Navigation buttons for primary functions

Above: Programming menu for sub-functions (example shown)

Special buttons
For brevity’s sake, we’ll cover only those controls which are unique in some way to
VoiceWorks 16 Installer. Other controls work just like they do in other Windows 95/98
programs. If necessary, consult your Windows 95/98 documentation.
•

Navigation — See “Function Numbers” (above).

•

Programming and Maintenance — Each selects the mode you’re in. As a safety feature,
when you are programming, you may not perform maintenance
(see “Maintenance menu,” page 6); and vice versa.

•

•

Apply — Immediately implements a setting you’ve made. Appears only when you’re
on-line (see “Opening a site,” page 7).
OK — Works the same as Apply (above), but also
will “back up” one function code level — e.g., from 15
back to 1.
Cancel — Cancels any current operation without changing settings. Appears only when
you’re on-line (see “Opening a site,” page 7).
Help — Assists you with the specific head function (1–7) you’re presently using.2

•

Pop-up (

•
•

) — Brings up a dialog box in which you can make more detailed settings.

Data-entry fields
Some settings require textual entries; some require only that you click on a checkbox (
perhaps a radio button ( ).
1
2

) or

The on-screen “F” buttons do not correspond to your PC’s “F-keys”; similarly, your PC’s “F-keys” do not trigger these buttons.
For more generalized help, use the Help menu (see page 6).
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Introduction to using the software
The main screen
After Installer starts, it will present the main screen. From here, you may open an existing site,
create a new site or manage your site information. It is only when a site is open that you can
directly access function numbers. You may also print or view the Installation Manual,
Administrator Manual, User’s Guide and User’s Pocket Guide. (As mentioned on page 1, you
will have to install Adobe Acrobat Reader, not provided in this software package, to view or
print manuals.) Reports can be viewed on-line. Additionally, backing up the system
configuration and restoring a configuration is accessed from the Windows menu bar at the top
of the screen. The following menus are available on the Windows menu bar:
•
•
•
•
•
•

File
Programming (usable only when a site is open)
Documentation
Reports (usable only when on-line)
Maintenance (usable only when on-line)
Help

File menu
Open Site
Displays a complete list of sites currently available on the hard drive.
Simply highlight a site and select OK. Editing the site information is not
available here (see “Site List,” page 5). For more information, see
page 7.

New Site
Displays a window in which you enter the basic information. The only required information is
a site name. While the description is optional, we recommend entering the site telephone
number at this time; however, you may also add or change it later. For more information, see
page 7.

Audit Site Data
Analyzes the site database for certain common programming errors. The report will appear on
screen and can be printed.

Send Site Data
Allows you to initially program a site off-line and then, when connected on-line later, send the
programmed data. Installer will automatically perform a site audit before sending the
database, and warn you of common errors.
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Site List
Displays a complete list of existing sites.
Information displayed there includes site name,
description, software version, disk version,
VoiceWorks 16 unit serial number and site
telephone number.3 Site List lets you:
• Enter a new site.
• Delete permanently a site and its database.
• Edit the site database name, description,
feature set and telephone number.
• Rename a site database.
• Copy the site’s database to a floppy diskette.

Programming menu
This lets you access a specific sub-function without having to
progress first through the sub-function’s head function; e.g., you
can go straight to Function 1432 without first having to go
through Function 1, then Function 14 and then Function 143
(see the second graphic on page 3).
This menu will become much more useful as you become more familiar with VoiceWorks 16
programming, because it will save you valuable time in gaining access to sub-functions you
already know.

Documentation menu
All end-user, Administrator and Installer documentation can be viewed
and printed from this menu. When you select a document, a window
(lower right) shows you available sections, if any, to view (in Acrobat
Reader, which will launch automatically when you
choose to view a document) or print. While this window
is on-screen, you may also view or print another
document by highlighting its name in the window’s left
side. Here are some tips:
•

The Installation Manual and User’s Guide are each
displayed as a list of sections. Check the box next
to the section(s) of the document you wish to print, then click on Print. To print the entire
selected document4, check Entire Document, then click on Print.
• Acrobat Reader lets you view, on-screen, one section at a time. Highlight the desired
section and click on View.
Important: Before printing, make sure Acrobat Reader isn’t running.5 You may wish to click
on the “minimize” icon (
) in the upper right corner of the Installer screen, to
make it easier to confirm that you’ve closed Acrobat Reader.
3

The software version, disk version and VoiceWorks 16 serial number are set automatically when the site is connected on-line.
This is your only choice for printing the Administrator’s Guide and the Pocket Guide; neither is sectioned.
5
While the printing function does use Acrobat Reader, the particular way that Windows 95/98 controls the process requires that
Acrobat Reader not be running when you try to print from within VoiceWorks 16 Installer.
4
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Reports menu
Four reports are accessible:
•
•
•
•

System Programming
Auto Attendant Statistics
Extension/Department Statistics
Voice Mail Statistics

The Reports menu is usable only when connected on-line, either remote (modem) or local
(serial), to a VoiceWorks 16.
1.

Select the desired report and a window will pop up, highlighting the report you selected.

Note: You can clear the totals for any report (except the System Programming report,
which you cannot clear) after it’s compiled by checking the Clear box. If totals are
not cleared, the system will continue to accumulate data, and the next report will
include cumulative data.
2. Click on Start. You will be prompted either to print the report or view it on screen.
The report is automatically saved to the disk as an ASCII file (i.e., pure text with no formatting)
and may be read later with a text reader or word processor. (Either NotePad or WordPad,
each of which comes with Windows, will do just fine.) Be sure to note the file name so you
may find it later using either the text reader, word processor or Windows Explorer.

Maintenance menu
This lets you back up or save the system configuration to disk, restore it
from disk or send a system configuration to VoiceWorks 16.
The Maintenance menu is usable only when connected on-line, either remote (modem) or
local (serial), to VoiceWorks 16.
Except for initial programming, ESI recommends backing up a system before
performing ANY off-line programming. The On-site Administrator may have made changes,
such as adding mailbox users, to the system since the last time you made a backup.
Warning: Failure to back-up prior to off-line programming could result in
irreversible deletions of mailboxes, which may contain messages.
Care must also be exercised when restoring a system. Restoring should take
place only on either new drives or drives that have been re-initialized.
Restoring to a drive which contains programming or messages will
result in over-writing all programmed data.

Help menu
The Help menu provides four options:
• VoiceWorks Installer — The manual you’re reading now.
• Frequently Asked Questions (FAQs) submitted to ESI
Tech Support.
• About — Provides the version number of the VoiceWorks 16 Installer you are using.
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New Site
Selecting New Site from the File menu will
display a window (top, right) to enter sitespecific information, such as site name,
feature set, a description and site telephone
number. Use New Site whenever you do the
initial programming, or the first time you
modify the programming of an existing site
by using VoiceWorks 16 Installer.
After entering the site-specific information,
you will be prompted to program on-line or
off-line (bottom, right). (See “Off-line or online?” on page 8.)
Important: If programming an existing site,
we highly recommend backing
up the system on-line before
doing any off-line programming
(see the Warning under “Offline,” page 8).

Open Site
Selecting Open Site
from the File menu
will display the
Select a Site dialog
box (left), a list of the
sites currently
available in the site
list.
Simply highlight a
site and click on OK
(or double-click on
the site name). The
Site Connection
window (right)
will appear.
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Off-line or on-line?
Off-line
The default selection is Off-line, so simply click on
OK to program off-line. A reminder will appear (right)
that recommends backing up the remote system
before making any changes to the database. This
will ensure that the database you modify off-line
accurately reflects the current system settings.
Warning: The site administrator may have made changes to the system — e.g., adding
mailboxes — since the last backup. If these changes do not appear in your
off-line programmed database, they will be deleted from VoiceWorks 16 when
the site data is sent to it.The deletions will be irreversible!
Click on Yes to begin programming.

On-line
Selecting On-line and clicking on OK will open the
window further (right) to select either Direct
Connection (Serial) or Via Modem. (See next
page for more information.) Regardless of which
you select, you will need to select the correct COM
port for that method and a baud rate.

Direct Connection (serial)
This will support a 38,400-baud rate.6 Verify the
serial connection before clicking OK to continue.
The required cable is a DB9/male-to-DB9/female.
Once connected, you will be prompted to enter the
installer password (the default is 789).
Begin programming values as described in
the VoiceWorks 16 Installation Manual.

6

If you leave the setting at 38,400 baud, VoiceWorks 16 and the connected serial device will negotiate the highest possible rate.
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Modem Connection
Connection via modem will be at 14,400 baud or
less, so time spent loading data to and from
VoiceWorks 16 may vary.
When Modem Connection is selected, the window
will be opened further. If this is the initial setup of
Installer, you will be prompted at this time to set up
your modem. Select your modem from the list
(lower right) and click the OK button. Modem types
may be changed later by clicking Modem Setup.
(If your modem is not listed, click on Cancel so you
may manually enter the modem setup settings.7
Do so, then click on OK.)
Once the modem setup is complete, verify the
correct telephone number and make any necessary changes to the number.
Important: Your modem call must be answered by or transferred to the VoiceWorks 16
Automated Attendant.
Access the modem by dialing 9 8 8 at the
main greeting ID branch. You may insert pauses into the telephone number string, between
the site telephone number and the 988 input, by including commas (,). Each comma is
approximately 2 seconds. An example is:
18005551212,,,,988
The pauses allow a time delay, giving the remote site time to answer, before dialing the 988
access code. This is very effective in applications that answer with the auto attendant.
Live-answer requires the called party to transfer the modem call to the VoiceWorks 16
extension. This must happen before the digits 988 are dialed by the modem. Methods we
have found effective are:
•
•

Call the site first, tell the person who answers that the next call he/she takes will be the
modem and ask him/her to transfer to voicemail.
Or, use a single-line telephone connected to the phone port of the modem, if it has one.
After the site answers, pick up the single-line phone and ask to be transferred to voicemail.
When transferred, put the single-line on-hook and wait for the 988 to be dialed.

At this point, you’re connected to the remote
VoiceWorks 16. You will be prompted to
enter the Installer password. After you
have done so, you will see a dialog box
(right) prompting you to choose which
operation to perform. Pick one and click on
OK.
Note: Selecting Programming puts you into Programming Mode, while selecting either
Backup or Restore puts you into Maintenance Mode. As the box says, you can switch
from one to the other at any time using either the Programming button or the
Maintenance button at the main screen’s lower left (see page 3).

7

This information may be in the modem manual, or you may need to call the modem manufacturer.
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Opening a site stored on floppy disk
Sites which have been copied to floppy disk can be added to the sites on the local hard drive
using the following procedure.
Open Windows Explorer if it’s not already open.
Click on View.
3. Click on Details.
4. Click on the icon for the appropriate floppy disk (usually A:\). The disk’s files should appear in
the right-hand side of the Explorer window.
5. Find the site database on the floppy. Site databases end with a .v16 extension.
1.
2.

6.
7.
8.

9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
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Note: The site name is the same as the filename (without the extension) — e.g., if the
site file is bank.v16, the site name is Bank. (You’ll need the site name in step 13.)
Right-click the database file on the floppy.
Select Copy.
Locate the Sites folder. Unless you specified differently
in the initial setup (see page 2), this directory is
c:\esi\VoiceWorks 16 installer\sites. The easiest way to
do this is to click on the little “+” box for each folder to
expose the next sub-level down. When the level is exposed,
the box has a “–” instead (right).
Click on that folder so that its contents appear in the righthand side of the Explorer window.
Right-click on any blank area within the right-hand side of the Explorer window (make sure
you don’t click on any existing file or folder).
Select New.
Select Folder. This will create a new folder within the site directory.
Give the new folder exactly the same name as the site (see step 5), by typing the folder name
and then pressing Enter.
Right-click the newly created folder.
Select Paste. This copies the database file to the VoiceWorks 16 site directory’s new folder.
(You may close Windows Explorer now, if you wish.)
Return to (or open) VoiceWorks 16 Installer.
Select File.
Right-click on Site List.
Right-click on Add.
Enter the name of the site you are moving (e.g., “Bank” — with no quotation marks, of course).
Click on Close.
Select File.
Right-click on Open Site.
Highlight the site you just added and click on OK; then proceed as normally.
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Using safeguard files
VoiceWorks 16 Installer not only saves each site file as a .v16 file but also automatically saves
a duplicate, safeguard site file; it uses a .bak extension. To use a safeguard file to recover to
your most recently saved setup if something goes wrong during a programming operation:
1.
2.
3.
4.
5.
6.
7.

Close VoiceWorks 16 Installer if it’s running.
Open Windows Explorer if it’s not already running.
Click on View.
Click on Details.
Locate the Site folder. (See step 8 under “Opening a site stored on floppy disk,” page 10.)
Click on that folder so that its contents appear in the right-hand side of the Explorer window.
Right-click on the appropriate site file, such as bank.v16, for which you need to recover to your
most recently saved setup.

Note: Windows Explorer will require you to rename this file (as we will do in steps 8–12)
before you work with the safeguard file.
8. Click on Rename. This will highlight the filename for editing.
9. Press the End key to move the cursor to the end of the filename.
10. Backspace over “v16” (but not the period) and type “saf” or some other extension.

11.
12.
13.
14.
15.
16.
17.
18.

Note: If you see a box warning about the file becoming unusable and asking whether
you’re sure you want to change the filename extension, just click on Yes.
Right-click on the site’s appropriate .bak file, such as bank.bak.
Select Copy.
Right-click on the right-hand side of the Explorer window (i.e., do not click on any file).
Select Paste. This creates a copy of the .bak file so you can return to it if necessary.
Right-click on the .bak file.
Click on Rename. This will highlight the filename for editing.
Press the End key to move the cursor to the end of the filename.
Backspace over “bak” (but not the period) and type “v16” — this turns the safeguard file into a
site file. (You may close Windows Explorer now, if you wish.)

Remaining functions
The VoiceWorks 16 Installation Manual (and its Acrobat Reader version — easily accessible
from Installer’s Documentation menu — shipped with this software) provides extensive
instructions for programming VoiceWorks 16.

11

Installer software

VoiceWorks 16

Technical support
Error log
VoiceWorks 16 Installer has a built-in debug program. In the unlikely event that Installer has
an operational error, a dialog box will appear, reporting the error and prompting you to type
exactly what you were doing when the error occurred. This will create a file within the
application (fserror.log) that reports in detail to our software engineers, the nature and cause
of the failure.
Please report any bugs to the ESI Technical Support Center (see below); be prepared to
provide a copy of the error log.

ESI Technical Support
The ESI Technical Support Center is available 7 AM–7 PM Monday through Thursday and
8 AM–5 PM Friday (all times Central). If you need assistance with VoiceWorks 16 Installer that
this software’s Help files, its Acrobat Reader files and your printed documentation don’t
provide, please contact ESI Tech Support by either calling 800 491-3609, faxing to
972 422-9705 or sending e-mail to techsupp@esi-estech.com.
Note: If you have any questions about setting up and/or using Adobe Acrobat Reader on
your PC, please point your browser to the Adobe Web site at http://www.adobe.com.
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